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Chapter 1: The HyperSign Family of Programs

There are three different versions of HyperSign available, each offering a feature set suitable to a particular
group of users: HyperSign Teacher’s Version, HyperSign Personal Version and HyperSign for Kids.

HyperSign HyperSign HyperSign
for Kids Personal Version Teacher’s Version

Full Motion Video √ √ √
Age Level Specific Vocabulary √ √ √
Spanish and English √ √ √
Children’s Activities √ √ √
About 450 pictureable signs √ √ √
Custom Word Lists √ √ √
Fingerspelling √ √ √
Activity Word List Manager √ √ √

Adult/Teen Dictionaries √ √
Approximately 2000 Signs √ √
Adult/Teen Activities √ √
Everyday Phrases √ √
ASL Conventions √ √
On-Line Bibliography √ √

Vocabulary Manager √
Bibliography Manager √
Student Manager √

Under no circumstances are we suggesting that a person can learn and be proficient in sign language
simply by using HyperSign any more than any dictionary can be used solely in teaching any language. Nor
are we suggesting that persons using HyperSign could or should replace professional interpreters who,
alone, can provide Deaf persons access to clear and complete communication skills. HyperSign was
developed to meet many of the needs we perceived as hearing people attempt to learn a language of another
culture ... a language very different in content, form, and use from English or other spoken languages.

HyperSign is centered around a video dictionary of approximately 2000 basic ASL signs (about 450
picturable signs in HyperSign For Kids). The signs were taken from the curriculum of A Basic Course in
Communication (NAD) and were recorded at NTID by Deaf and hearing members of the Sign Communication
Department. The authors of this program, as well as the members of the Communication Training Program
at NTID, realize that ASL dialects exist. Some sign synonyms are signed in ASL and SEE.

Many features have been included in HyperSign to enhance the learning experience and increase the
potential for success in learning, retaining and using ASL including:

•  Full Motion Video
The full motion video of ASL signs include the facial expressions or gestures accompanying the sign which
change their meanings. Each sign has a base sign representing the one most commonly used in daily
conversation.  If there is more than one sign which fits that word, all variations of the signs are available.
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•  Age Level Specific Vocabulary
Since vocabulary varies with age, HyperSign provides access to the video dictionary at three levels. Users of
the adult’s dictionary have access to all 2000 signs. The teen dictionary is a subset of the adult dictionary.
The child’s dictionary was specially designed for nonreaders and pre-readers with each word (approximately
450) accompanied by an easily recognizable picture.

•  Spanish and English
Since Spanish is the second most commonly used first language in this country, the program is designed to
provide instructional text in either Spanish or English.

•  Children’s Activities
Games are fun and they enhance the learning process and increase retention. We have included three
games for children: Which One?, Matching Game and Tic Tac Toe.

•  Adult/teen Activities
There are also four games for teenagers and adults, including a Crossword Puzzle, Name That Sign, What’s
My Sign?, and You First!. (Personal and Teacher Versions only)

•  Custom Word Lists
Often teachers or parents want to focus attention on certain specific lists of words. HyperSign allows
teachers or parents to create lessons containing specific lists of signs selected from either the adult, teen or
child’s dictionaries for classroom or in-home use.

•  Everyday Phrases
Language learning includes more than learning the words of a language. The words need to be combined to
form sentences. We have included a number of everyday phrases chosen to give users something to say.
(Personal and Teacher Versions only)

•  ASL Conventions
All languages have rules of grammar and rules of usage. Some of the rules that govern the use of ASL have
been included in an on-line document titled More Than Meets the Hand: A Guide for New Users of ASL
which offers both written and signed examples of the uses of ASL. (Personal and Teacher Versions only)

•  On-Line Bibliography
Language learning is enhanced if (or incomplete unless) the features of the culture are known. The culture of
Deaf persons is just beginning to be appreciated and studied. Deaf persons usually learn about their culture
from their Deaf peers since only 3% of Deaf children have one or more Deaf parents. As a service to teach-
ers and especially parents, an extensive bibliography on Deafness and Deaf Culture is accessible from the
program. This bibliography includes books for children, sign language learning books, books about deaf-
ness, videotapes, etc. (Personal and Teacher Versions only)

Potential Users and Suggested Uses

There are many potential beneficiaries of a program that could be used to effectively help learn ASL. Listed
below are some of the groups of people we think could benefit from the different versions of HyperSign and
what we think their benefit might be. This list is certainly not exhaustive.

HyperSign For Kids

•  Family Members of Hearing-Impaired Children
This group includes grandparents, aunts, uncles, cousins, mothers, fathers, sisters and brothers. Since
communication is the key in the life of a family, this is the most important user group for this product. Years
of experience have shown that fluent, effective communication is a primary concern of the parents of hearing
impaired children. Parents often feel they can’t communicate with their hearing-impaired child (How could s/
he hear what I am saying?) or that the signs they use will not be correct. This is especially frustrating since
early stimulation and communication is crucial in establishing the parent-child bond and building a founda-
tion for skills learned later in life. Children learn about the world and themselves through language.
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It is often difficult for parents to schedule time to take sign language classes and the classes themselves
are often intimidating. Parents are often afraid to imitate, ask for repetitions, or try out their skills at home.
This program provides a confidential, self-paced learning tool for parents and other family members. It allows
them to design their own lessons and practice at home and provides instant access to signs they need in
the home ... not merely those listed in a book or taught in a class.

•  Peers (Playmates) of Hearing-Impaired Children
Through play children learn about things and how they work. Important social skills including sharing, rules,
competition, losing, and negotiating are also learned through play. Piaget said “play is a child’s work”. Even
though language is not a prerequisite for play, it enhances the value of play and stimulates the development
of interpersonal relationships.

HyperSign Personal V ersion

•  Family Members of Hearing-Impaired Children

•  Peers (Playmates) of Hearing-Impaired Children

•  Sign Language Learners
Learning sign language (or any language) is difficult unless there are opportunities for repeated exposure to
both the vocabulary and the rules of use. People also learn and retain vocabulary and language that serve a
purpose in their daily lives. This program provides a tool through which vocabulary can be learned and
reviewed.

•  Medical Care-givers Working with Doctors or in Hospitals
These personnel may have contact with Deaf persons in both emergency and non-emergency situations. A
knowledge of the basic vocabulary relating to illness and injury would make their care of Deaf individuals
more effective and more efficient. Deaf persons would also feel less threatened if someone in the medical
environment could communicate with them until a professional interpreter arrived.

•  Personnel Directors, Co-workers, Supervisors, and Managers
The implementation of ADA and the Equal Employment Act has increased the numbers of handicapped
(Deaf included) persons in the workplace. The ADA mandates that companies make certain that their
services are accessible to handicapped consumers. While employment of Deaf persons has increased,
these employees often report feelings of isolation and loneliness unless there is someone with whom they
can communicate.

Although interpreters should always be used for job related communication, the learning of basic conversa-
tional signing by employers would send a positive message concerning a company’s commitment to making
their Deaf employees feel more comfortable and an integral part of their own workplace. Not surprisingly,
some businesses have found that training their sales staff in basic sign communication not only generates
good public relations but also increases their sales and sends the message that the owner values the
business of the Deaf customer.

•  Professionals in Speech-Language Pathology, Audiology, and Special Education
A familiarity with ASL would be advantageous for these professionals since professional interpreters are
usually not available when they are consulting with Deaf persons. In addition, sign language has also been
used successfully to establish communication with persons who are retarded, autistic, or who display other
problems which prohibit or impede ordinary spoken communication.

HyperSign T eacher Version

•  Professionals in Speech-Language Pathology, Audiology, and Special Education
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•  Classroom Teachers and Other School Personnel
Since the passage of PL 94-142, the Education of All Children Act, in 1972, handicapped children, including
Deaf children, are mainstreamed into neighborhood schools. Even though Deaf children are provided with
professional interpreters, they still report feeling like outsiders in school. These feelings of isolation and
loneliness could be significantly reduced if classroom teachers knew and could use conversational signing
and if other school personnel (cafeteria people, secretaries, bus drivers, school nurses, playground supervi-
sors, etc.) would learn basic conversational signs.
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Chapter 2:  Installation of HyperSign For Kids

The minimum hardware and software requirements for HyperSign For Kids are a multimedia compliant PC:

• 386DX/33 MHz with 8 MB RAM (16 MB recommended)
• 6 MB of free hard disk space
• double speed CD-ROM drive
• VGA monitor running in 256 colors (thousands of colors recommended)
• Windows 3.1 or Windows 95/98/NT/ME
• Windows compatible sound card
• QuickTime™ for Windows

Installation Instructions

Place the HyperSign CD in your CD drive. Choose Run...  from the File  menu (Win 3.1) or click on the Start
button, and choose Run...  from the Start menu (Win 95/98/NT/ME). Enter X:\SETUP (where X is the drive
designation of your CD drive) and click OK. Follow the on-screen prompts. Choose Yes when prompted to
create Program Manager Groups.

Checking Your Video Drivers

The video clips used in HyperSign are in the QuickTime™ format. Open your Control Panel utility and select
the Drivers  option. Make sure you have a driver installed that can run QuickTime movies. You should see an
entry something like: [MCI] QuickTime for Windows. If you do not, you can install one from the HyperSign
CD. Open the HyperSign CD and then open the subdirectory (folder) HSUTILS. Double click on the
SETUP.EXE program to install QuickTime for Windows on your computer. Note: HyperSign requires the
16-bit version of QuickTime for Windows (QTW) contained in the folder HSUTILS. Even if you
already have the 32-bit version of QTW installed on your system you must install this 16-bit version.
Both versions can coexist on the same system.

Starting HyperSign For Kids

Make sure that the HyperSign CD is in the CD ROM drive. If you are running Windows 3.1, open the
HyperSign program group and double click on the icon for the HyperSign For Kids program. If you are
running Windows 95/98/NT/ME, click on the Start  button, choose Programs  from the Start menu, select
HyperSign For Kids  and finally choose the HyperSign For Kids  menu item. The main HyperSign For Kids
dictionary window is displayed.

Setting the Program Preferences

Select Preferences... from the File menu. The options on the Preferences screen allow you to set language
used and to adjust the sound options. The language option determines the language in which the menu
items are displayed and the language used for the written words accompanying the signs. Select the
language (English or Spanish) you prefer from the pop-up button. The chosen language will be preceded by
a black dot.

The program provides audio responses (bell and buzzer sounds, etc.) to user’s answers in the various
activities. Clicking on the Game Feedback check box toggles this option on and off. Use the slide bar to
set the default volume and click on the picture of the little girl to hear a phrase spoken. If you have external
speakers, set the slider bar to a medium position and adjust the volume with the controls on your speakers.
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Chapter 3:  Using HyperSign For Kids

HyperSign For Kids was specially designed for nonreaders and pre-readers. It provides a visual interface and
each word in the dictionary is accompanied by an easily recognizable picture. The words were chosen from
the text Basic Vocabulary and Language Thesaurus for Hearing-Impaired Children by Daniel Ling and Agnes
Ling (Alexander G. Bell Association for the Deaf, Washington, D.C., 1977).

The Child’s Dictionary

When you start HyperSign For Kids the main dictionary screen is displayed. This screen shows a bookshelf
at the top-left, a TV at the top-right and a book cover at the bottom left. The vocabulary is grouped into 26
categories, each
containing about 25 words. Each category title is represented in picture and written forms:

Action Words (a-g) Holidays
Action Words (h-z) House
Animals How Much
Body Miscellaneous
Clothes People
Colors Outside
Descriptions (people) Places
Descriptions (things) Pronouns
Everyday Verbs (a-g) School
Everyday Verbs (h-z) Time
Family Transportation
Foods When
Fruits & Vegetables Where

When the dictionary screen is dis-
played, the Action Words (A-G) book is
removed from the bookshelf. Click on
the book cover to open it to the first
entry (ask). The written form of the word
in the dictionary is displayed on the left-
hand page of the open book and a
picture of the word is displayed on the
right-hand page. If you click on the little
girl icon on the left page of the open
book, the word is pronounced. If you
click on the picture on the right page of
the open book, the first frame of the sign
appears in the movie window. Beneath
the movie window are the buttons for
controlling the movie. Clicking on the
left-most button plays the entire movie.
Click the button second from the left
plays the sign movie in slow motion
(i.e., one frame at a time) and beeps
when the sign movie is finished.
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To turn the pages of the book, click on the arrows on either side of the scroll bar beneath the book or on the
dog-ear corners of the pages. At the far right of the scroll bar is a pop-up button. Click this pop-up button to
display a list of all the words in the book. Click on the word you are interested in and the book page
changes to display the word you selected.

The bookshelf at the top left contains additional books organized by categories children easily recognize.
Click on the arrows below the bookshelf to choose a different book. Each time you click on these arrows, a
new book is removed from the bookshelf and its cover shown. When the book cover for the category of
words you are interested in is displayed, click on it to open it so you can page through the book and find the
words whose signs you want to review. At the far right of the scroll bar under the bookshelf is a pop-up
button. Click on this button to display a list of all the categories. Click on the category you are interested in
and the book cover for that category will be displayed.

Lastly, to quickly find a word, type it into the text box above the Find button on the right of the screen and
click on the Find button. The program will search the dictionary and, if the word is found, display the appro-
priate book opened to that word.

That’s all there is to using the HyperSign For Kids dictionary. It’s easy and children have no problem finding
words they are interested in and viewing the signs.

The Child’s Activities

Learning sign language is a lot of fun for children. To add to the excitement of learning a new language we
have included a review option, a section on fingerspelling and three activities especially designed for chil-
dren. These are available from the Activities menu.

Learn the Words

This activity is provided so children can view and practice the signs that make up the specific lists used in
the other Activities. This is especially useful if an adult has created special lists for the children to use in the
Activities. (See Chapter 4 for a discussion on how to create specific lists of words.)

When you choose Learn The Words
from the Activity menu, a screen is
displayed that is similar to Child’s
Dictionary screen. At the left is a field
listing all the currently available lists of
words. Below the movie window is the
familiar open book showing the written
form of the word on the left-hand page
and the pictured form on the right-hand
page. If you click on the little girl icon
on the left-hand page of the open book,
the word is pronounced. If you click on
the picture on the right-hand page of the
open book, the first frame of the sign
will appear in the movie window. Be-
neath this window are the buttons for
controlling the movie. Clicking on the
Play button plays the entire movie.

To turn the pages of the book, click on the arrows on either side of the scroll bar beneath the book or on the
dog-ear corners of the pages. At the far right of the scroll bar is a pop-up button. Click on this pop-up button
to display a list of all the words in the chosen list. Click on the word you are interested in and the book page
changes to display the word you selected.
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Which One?

This game gives children additional practice on recognizing signs and is appropriate for even very young
children.

When Which One? is chosen from the
Activities menu, a new screen is
displayed with 3 pictures in the middle
of the screen and the movie window on
the right. Click on the Play button
beneath the movie window to see a
person signing one of the words repre-
sented by the pictures. You can view
the movie as many times as you wish
by clicking on the Play button. When
you recognize the sign, click on the
picture representing the sign from the
three choices. If you are correct, the
happy face lights up, a bell rings and a
happy face is displayed in the counter
under the faces. If you are wrong, the
sad face lights up and a message is
spoken. No marker is placed in the
counter. You can guess again. After two
wrong guesses, the picture for the
correct answer is highlighted and the
movie showing the sign is played before
proceeding with the game.

Each game consists of a maximum of nine questions unless there are fewer than nine items in the chosen
word list. After the completion of the game, you can play another game with the same list by clicking on the
New Game button or choose a different group of signs from the Current Lists scrolling field just below the
movie window.

Tic Tac Toe

Children of all ages know how to play Tic Tac Toe. HyperSign’s version of Tic Tac Toe is a little different in
that the goal is to help children learn various signs within the context of this familiar children’s game.

When you choose Tic Tac Toe from the
Activities menu a screen is displayed
showing the typical “tic tac toe” game
board with all nine spots occupied with
the same picture of a little girl. To start
the game, click on the picture occupy-
ing the position on the game board you
would like to place a “happy face”. The
program places a question mark in the
chosen position on the game board,
displays three pictures in the boxes
below the game board and displays the
first frame of a movie in the movie
window.
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To place a “happy face” in the chosen game board position, you need to identify which of the three pictures
represents the sign shown in the movie. Click on the Play button to view the sign. Then click on the picture that
represents the sign shown. You get two chances to identify the correct picture. If you correctly identify the sign,
a “happy face” is displayed in the chosen game board position; if you are incorrect, a “sad face” is displayed.
The game continues until you get three “happy faces” in a row (vertically, horizontally, or diagonally).

After the completion of the game, you can choose to play another game with the same word list by clicking
on the New Game button. Since most lists will contain more than nine signs and the signs are presented
randomly, you can play the game with the same list many times and continue to see different signs. The
Current Lists scrolling field offers other lists of related signs for use in this game.

Match Game

This game is a little more difficult. Children will learn signs as well as the fingerspelling alphabet while
playing. When a child selects Match Game from the Activities menu, a new screen is displayed showing
12 small squares. Behind each square is a picture of a fingerspelled letter of the alphabet. There are 6 pairs
of matching pictures hidden on the game board.

The first challenge is to find matching
pictures of the fingerspelling alphabet.
To do this, you click on two of the game
board squares. If the two picture don’t
match, the sad face is highlighted and
the pictures are covered up. If the two
pictures match, the happy face is
highlighted, a bell rings, the two pic-
tures are moved to the box above the
game board. Matching all 6 pairs
uncovers a fingerspelled word on the
game board, displays three pictures in
the boxes below the game board and
the first frame of a movie is displayed. If
you click on the little-girl button in the
center of the game board, the word will
be fingerspelled. You can also click on
the Play button to view the movie of the
sign. To win the game, you must
identify the fingerspelled word by
clicking on the picture that correctly
represents it.

After the completion of the game, you can choose to play another game by clicking on the New Game
button or choosing a new word list from the Current Lists scrolling field.

Fingerspelling

The fingerspelling module helps children learn to form the hand-shapes for each letter of the alphabet.
Fingerspelling is used by Deaf persons to spell a proper noun (the name of a city or person), or to spell a
word which has no sign. Beginning signers will use fingerspelling a great deal until their vocabulary of signs
is large enough for conversational purposes.

The Fingerspelling screen shows the letters of the alphabet, the movie window and a scrolling text field
below the movie window. When you click on a letter on the left of the screen, the letter and a list of words
containing that letter are displayed. Click on the letter or one of these words in the list to see a signer
fingerspell that letter or word. By watching these words spelled you can see how the hand-shape for the
letter you have chosen is formed when it occurs with other letters. This will also give you practice in reading
someone else’s fingerspelling.
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Chapter 4:  The Activity Word List Manager Program

Word lists are used in HyperSign For Kids as a way of choosing sets of signs for the games and vocabulary
review items listed on the Activities menu. Word lists are groups of words that are in some way related to
one another. The relationship is up to you. For example, you might want to build lists of words and signs for
your children to review or practice at a later time or lists of signs specific for peers, grandparents or baby-
sitters. While HyperSign For Kids comes with a number of pre-built lists, this utility allows you to edit the
pre-built lists or create your own.

Starting the Activity Word List Manager Program

If you are running Windows 3.1, open the HyperSign program group and double click on the icon for the
HyperSign For Kids List Manager program. If you are running Windows 95/98, click on the Start button,
choose Programs from the Start menu, select HyperSign For Kids and finally choose the HyperSign For
Kids List Manager menu item. The main List Manager window is displayed.

Creating a New Activity Word List

Select New Activity Word List... from the File menu. Enter the name of the new list in the dialog box and
click on the Add List button. This creates a new, empty list. You may continue adding new lists. When you
are finished, click on the Done button. Note, you must create and name an Activity Word List before you
can add words to it.

Editing an Activity Word List

To choose a list for editing, select Open Activity Word List... from the File menu, click on the name of the
Activity Word List you wish to edit and then click on the OK button. The name of the list selected is dis-
played at the top right of the screen and the words in the list are shown in the scrolling field on the right of
the screen.
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After selecting an activity word list, the words in the list are displayed in the scrolling field at the right of the
screen and you can proceed to add or remove words to this list. To add a word to the named list, you first
find the word in the dictionary at the top left of the screen or use the Find a Word item on the Options
menu. Once you have found the word you want to add to the list, click on it in the scrolling field on the left,
hold down the mouse button, drag it to the scrolling field on the right and release the mouse button. You can
continue to add as many words to the list as you wish. All changes are automatically saved.

To remove a word from a list, click on it in the scrolling field on the right, hold down the mouse button and
drag it to the trash can. No confirmation is required.

You may view the sign movie of any of the words in the scrolling field on the left of the screen. Click on the
word to highlight it and then choose View Sign Movie... from the Options menu.

Deleting an Activity Word List

Choose Delete Activity Word List... from the File menu. A dialog box is displayed with all the activity word
lists in a scrolling field. Click on the name(s) of the activity word lists you wish to delete. When you click on
a name in the list, a red Del flag is displayed just to the left of the list name. If you change your mind about
deleting a particular word list, just click on its name again to toggle the Del flag off. After marking all of the
lists you wish to delete, click on the Delete Lists button and confirm you truly wish to delete these lists.

Specifying Which Word Lists are Active in HyperSign

Select Choose Active Word Lists... from the Options menu to specify which word lists are active in
HyperSign For Kids. A blue dot to the left of the name of the activity word list means that it is active in
HyperSign For Kids. To activate an activity word list, just click on its name in the list. The blue dot will be
placed to the left of its name. To deactivate a particular word list, click on its name again and the blue dot
will be removed. While you can only specify a maximum of nine activity word lists as active at one time, you
can change the active lists at any time using this option.

Designating Alternate Pictures and/or Recordings

Each word in the Child’s Dictionary has a picture and recording associated with it. Both the picture and
recording are used in the main dictionary page and in the Learn the Words activity. The pictures are also
used in all of the other Activities (games). Some users may want to use different pictures or different
recordings for a particular word in the child’s dictionary and so you have the option of designating an
alternate picture or recording for any of the words child’s dictionary.

Choose Assign Alternate Wav/Picture...
from the Options menu to display a dialog
box. In this dialog box, the word (or phrase)
from the Child’s Dictionary is displayed at the
top. On the left is a button to play the default
recording for this word and default picture is
displayed at the bottom. If there is an alter-
nate recording (WAV file) clicking on the radio
icon in the middle of the dialog box will play it.
And, if there is an alternate picture (BMP file)
for this word it is shown at the bottom-middle
of the screen.
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Only one alternate recording and/or picture can be assigned to a word. If you have defined an alternate
recording or picture and chosen to use it, the Alternate WAV  (and/or Alternate BMP ) radio button will be
checked. To use the alternate recording and/or picture, make sure the Alternate WAV  and/or Alternate
BMP radio buttons are checked and click on the Done  button.

Alternate Recordings
The alternate recordings must be WAV files. You can create these recordings using the Sound Recorder
utility (click on the Start  button and choose Accessories|Multimedia). You can also click on the Record
button (top, right) and make a recording from within this program. If you make a recording in this way, it is
automatically stored in the TempWavs folder (located in the HyperSign folder on your hard drive).

To use a recording you have made as the alternate WAV, click on the Browse for WAVs  button, navigate to
the folder where you have saved the recording, click on any WAV file and then click on the OK button. All of
the WAV files in the folder selected will be displayed in the scrollable field at the top right of the screen.
Click on one of these to highlight it and click on the icon of a radio to hear it played back.

To use this alternate recording, make sure the Alternate WAV  radio button is checked before you click on
the Done  button. After clicking Done, the program will copy the WAV file to the Altfiles folder and name it
so that it is recognized by the HyperSign program.

Alternate Pictures
The alternate pictures must be BMP files. You can create these pictures using your Paint program if you
choose. Ideally the BMP file should be 135 x 115 pixels (width x height).

To choose a picture as the alternate BMP, click on the Browse for BMPs  button, navigate to the folder
where you have saved the pictures, click on any BMP file and then click on the OK button. All of the BMP
files in the folder selected will be displayed in the scrollable field to the bottom right of the screen. Click on
one of these to highlight and display it. To use this alternate picture, make sure the Alternate BMP  radio
button is checked before you click on the Done  button. After clicking Done , the program will copy the BMP
file to the Altfiles folder and name it so that it is recognized by the HyperSign program.

Restoring Defaults
If you wish to restore the default recording and/or picture, make sure the Default WAV  radio button (and/or
the Default BMP  radio button) is checked and click on the Done  button. When the default recording (and/or
picture) is restored, the alternate recording (and/or picture) is irreversibly removed from the Altfiles folder.

Changing Movie Locations

For your convenience, we have provided a mechanism that allows you to install all of the media files on your
hard drive so you do not need to have the HyperSign CD in your CD drive each time you use the program.
You need about 600 MB of free disk space on your hard drive. If you have enough free space on your hard
drive and want to do this, use the following procedure.

1. From Windows Explorer or My Computer, display the contents of your hard drive. Then create a new
folder on your hard drive. You might name it HSMEDIA.

2. Copy the folders KISDPICT, MOVIES1, MOVIES2, MOVIES3, MOVIES4, MOVIES5, and SOUNDS to
the new folder you created in Step 1 above.

3. Start the HyperSign For Kids List Manager program. Choose Change Movies Location from the
Options menu.

4. In the dialog box displayed, click on the Hard Drive  radio button. Navigate to the MOVIES1 folder in the
folder on your hard drive created in Step 1 above. Open the MOVIES1 folder, highlight the file named
DICTION.MOV and click on the OK - Done  button.
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Chapter 5: Common Problems and Solutions

The following are the most common issues raised with technical support for HyperSign and the recom-
mended solutions.

1) A system error is displayed when the program tries to display a video clip.
The video used requires QuickTime for Windows. If the QuickTime for Windows driver is not installed on
your computer system, from File Manager (Windows 3.x) or Windows Explorer (Win 95/98), open the
HyperSign CD and then open the folder HSUTILS. Double click on the QTINSTAL.EXE program to install
QuickTime for Windows on your computer.

2) When I try to play a video I get a fatal exception error message and blue screen.
This problem has been reported by some users with Pentium II and Pentium III processors. The folowing
work-around seems to work in all cases. There are 2 places where changes need to be made: (a) in the
Quicktime Control Panel and (2) in the QTW.INI file (in the WIndows folder):

a) Changes to the Quicktime Control Panel:
1. Click on Start button. Choose Settings|Control Panels
2. From the control panel screen, double click on the quicktime icon. (If you have icons for both

QT32 and QT16, double click on the QT16 icon.
3. Click on the More button at the bottom right of the dialog box displayed. This will display some

tabs at the top of the dialog box.
4. Click on the Video tab.
5. In the middle of the dialog box is an area called Optimization and a scrollable field showing the

various Draw Methods available.
6. Click on (highlight) the Windows DIB item in this scrolling field. (If this doesn’t work, select the

RAW item in this field.)
7. Click on the Apply button at the bottom of the dialog box.
8. Click on the Close button at the bottom of the dialog box.

b) Changes to the QTW.INI file:
1. Open the QTW.INI file in the Windows folder in NotePad.
2. Under the [Video] section, change the optimize value to RAW (others have used Driver), that is,

Optimize=RAW
3. Save the changes.

Restart your computer. You may have to try a couple of different setting to resolve this problem.

3) I get error messages saying that a variable has been set to a null value or that the variable is out
of range.
This error has only occurred with Windows 3.1 users. The program makes extensive use of a variety of
databases and the database engine employed requires that the SHARE.EXE program is running. Refer
to your MS DOS Reference manual for the correct method for installing SHARE.EXE on your system.

4) The screen flashes when changing activities and the videos aren’t very clear.
This occurs when your system is configured to display 256 or fewer colors. The only way to fix it is to
set up your system to display more than 256 colors. Open the Start Menu and choose Settings: Control
Panels. Then open the Display control panel. Click on the Settings tab at the top, right of the control
panel. Then, set the Color Palette to at least high color (16 bit). Close the control panel.
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5) The bottom of the HyperSign window seems to go off the bottom of the screen.
This occurs when the Windows 95/98 task bar covers up the bottom of the HyperSign window. To
correct this, open the Start Menu and choose Settings: Taskbar. Then make sure the Auto hide check
box is checked. Now the Taskbar should be hidden and the entire HyperSign window will be visible. To
access the Taskbar, just move the cursor to the very bottom (by default) of the screen and the Taskbar
will appear.

If you need further help or have other questions regarding technical support, please send an e-mail message
to support@trinitysoftware.com. Be sure to specify that you are using HyperSign For Kids and carefully and
completely describe the problem you encountered.

revised 7/2001


